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Printer Parts

Accessories

Ink Cartridges

Caution: To ensure good results, use genuine Epson ink cartridges 
and do not refill them. Other products may cause damage to your 
printer not covered by Epson’s warranty.

Paper support 
and extensions Sheet feeder

Left edge 
guide

Printer 
cover

Output tray 
extension

Ink cartridge 
holder (in home 
position)

Control panel

Roll paper edge guide

Roll paper holder
IEEE 1394 
(FireWire) port

USB 
port

Paper support 
(closed)

Output tray

Roll paper 
guides

Manual Feed

Cartridge Part number

Light Light Black T059920

Light Magenta T059620

Light Cyan T059520

Light Black T059720

Photo Black T059120

Matte Black T059820

Cyan T059220

Magenta T059320

Yellow T059420

Single sheet guide

Matte sheet 
support Roll paper holders
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Epson Papers

* Availability of paper types varies by location. See page 12 or your 
paper instructions to select the Type or Media Type setting. If you 
load paper not listed as a setting in your printer software, you may 
see smears, roller marks, misting, or other problems.

** This matte paper requires the matte sheet support when loading 
multiple sheets 11 inches wide or wider; smaller paper can be 
loaded without it.

***This paper must be loaded one sheet at a time in the single sheet 
guide. 

Paper name* Size Part number

Epson Premium Bright 
White Paper

Letter (8.5 x 11 inches) S041586

Epson Photo Quality Ink Jet 
Paper

Letter (8.5 x 11 inches) S041062

Legal (8.5 x 14 inches) S041067

B (11 x 17 inches) S041070

Super B (13 x 19 inches) S041069

Epson Photo Quality Self 
Adhesive Sheets

A4 (8.3 x 11.7 inches) S041106

Epson Enhanced Matte 
Paper**

Letter (8.5 x 11 inches) S041341

A3 (11.7 x 16.5 inches) S041343

Super B (13 x 19 inches) S041339

Epson Matte Paper 
Heavyweight**

Letter (8.5 x 11 inches) S041257

8 x 10 inches, 
borderless

S041467

11 x 14 inches, 
Borderless

S041468

A3 (11.7 x 16.5 inches) S041260

Super B (13 x 19 inches) S041263

Epson Double-Sided 
Matte Paper**

Letter (8.5 x 11 inches) S041568

Epson Premium Glossy 
Photo Paper

Letter (8.5 x 11 inches) S041286, 
S041667

4 x 6 inches, borderless S041727, 
S041808

5 x 7 inches, borderless S041464

8 x 10 inches, 
borderless

S041465

B (11 x 17 inches) S041290

A3 (11.7 x 16.5 inches) S041288

Super B (13 x 19 inches) S041289

11 x 14 inches, 
Borderless

S041466

4 inches x 26 ft roll 
paper

S041302

8.3 inches x 32.8 ft roll 
paper

S041376

13 inches x 32.8 ft roll 
paper

S041378

Epson Premium Semigloss 
Photo Paper

Letter (8.5 x 11 inches) S041331

Super B (13 x 19 inches) S041327

4 inches x 26 ft roll 
paper

S041329

Epson Premium Luster 
Photo Paper

Letter (8.5 x 11 inches) S041405 

A3 (11.7 x 16.5 inches) S041406

Super B (13 x 19 inches) S041407

8.3 inches x 32.8 ft roll 
paper

S041408

13 inches x 32.8 ft roll 
paper

S041409

Proofing Paper Commercial 
Semimatte

Super B (13 x 19 inches) S041744

Epson Watercolor Paper - 
Radiant White***

Super B (13 x 19 inches) S041351

Epson Velvet Fine Art 
Paper***

Letter (8.5 x 11 inches) S041636

Super B (13 x 19 inches) S041637

Epson UltraSmoothTM Fine 
Art Paper***

Super B (13 x19 inches) S041896

PremierArtTM Water-
Resistant Canvas for Epson

13 inch x 20 foot roll SP91220

PremierArtTM Matte 
Scrapbook Photo Paper for 
Epson***

Letter (8.5 x 11 inches) SCR1002

12 x 12 inches SCR1003

Paper name* Size Part number
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Printer Specifications

Printing

Printing method Advanced Micro Piezo pigment ink
technology, optimized for photo printing

Nozzle 
configuration 1440 nozzles (180 × 8)

Standards and Approvals

Mechanical

Electrical

* Check the label on the back of the printer for its voltage.

Environmental

* Stored in a shipping container

** Without condensation

Ink Cartridges

* Ink thaws and is usable after approximately 3 hours at 
77°F (25°C).

Safety UL 60950
CSA C22.2 No.60950

EMC FCC Part 15 Subpart B Class B
CSA C108.8 Class B

Paper path Sheet feeder, top entry

Sheet feeder 

capacity

About 120 sheets at 24 lb (90 g/m²) paper

Dimensions Storage
Width: 24.2 inches (615 mm) 
Depth: 12.2 inches (314 mm) 
Height: 8.8 inches (223 mm)

Printing
Width: 24.2 inches (615 mm) 
Depth: 29.0 inches (737 mm)
Height: 18.0 inches (457 mm)

Weight  25.8 lb (11.7 kg) without the ink cartridges

120 V Model 220-240 V Model

Input voltage range 99 to 132 V 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.5 A (Max. 0.8 A) 0.25 A (Max. 0.4 A)

Power consumption Approx. 18 W 
(ISO10561 Letter 
Pattern)
Approx. 1 W in 
Sleep mode

Approx. 18 W 
(ISO10561 Letter 
Pattern)
Approx. 1.3 W in 
Sleep mode

Temperature Operation: 
50 to 95°F (10 to 35°C)
Storage: 
–4 to 104°F (–20 to 40°C)
1 month at 104°F (40°C)

Humidity Operation: 
20 to 80% RH
Storage:*,** 
5 to 85% RH

Color Light Light Black, Light Magenta, Light Cyan, Light 
Black, Photo Black, Matte Black, Cyan, Magenta, 
Yellow

Cartridge life Within 6 months of opening the package, at 
77 °F (25 °C)

Temperature Storage:
–4 to 104 °F (–20 to 40 °C) 
1 month at 104 °F (40 °C)
Freezing:*
3.2 °F (–16 °C)

Dimensions 0.5 inch (12.7 mm) [W] × 2.89 inch (73.5 mm) [D] × 
2.18 inch (55.3 mm) [H]
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Paper

See page 2 for a list of special paper distributed by Epson.

Caution: Poor quality paper may reduce print quality and cause 
paper jams or other problems. If you encounter problems, switch to 
a higher grade of paper.

Do not load curled or folded paper.

Use paper under normal conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

Epson Photo Quality Self-Adhesive Sheets should be stored under 
the following conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Printable area

Single sheets

Roll paper

Single sheets

Size Letter (8.5 × 11 inches[216 × 279 mm])
Legal (8.5 × 14inches [216 × 356 mm])
A4 (210 × 297 mm)

4 x 6 inches (113.6 × 175.4 mm)
5 × 7 inches (127 × 178 mm)
8 x 10 inches (203 × 254 mm)
11 x 14 inches (279 mm x 356 mm)
Super B (329 x 483 mm)
US B (11 x 17 inches)
A3 (297 x 420 mm) 
A6 (105 x 148 mm) 
12 x 12 inches (30 x 30 cm)
Panoramic 210 x 594 mm 

Paper types Plain bond paper, special paper distributed by 
Epson

Thickness

(plain bond paper)

0.003 to 0.004 inch (0.08 to 0.11 mm)

Weight

(plain bond paper)

17 lb (64 g/m²) to 24 lb (90 g/m²)

A: The minimum top margin is 0.12 inch (3.0 mm).

B-L: The minimum left margin is 0.12 inch (3.0 mm).

B-R: The minimum right margin is 0.12 inch (3.0 mm).

C: The minimum bottom margin is 0.12 inch (3.0 mm).

A

C

B-L B-R

Standard margins

Pressing the z roll paper button after printing prints 
the cutting guideline.
If you press the z roll paper button again and send 
print data, the margin between the printouts is about 
65 mm.

If you send a print job that has multiple pages, or 
send print jobs continuously, there will be no margin 
between the printouts.

Borderless

Pressing the z roll paper button after printing prints 
the cutting guideline.
If you press the z roll paper button again and send 
print data, the margin between the printouts is about 
65 mm.

If you send a print job that has multiple pages, or 
send print jobs continuously, there will be no margin 
between the printouts.
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Control Panel

To diagnose printer problems, check the printer’s lights or run 
a printer check (see below).

Running a Printer Check

You can run a printer check to determine whether a problem 
comes from the printer or some other source. 

1. Turn off your printer and computer, then disconnect the 
printer’s interface cable.

2. Load letter-size paper in the sheet feeder.

3. Hold down the ) paper button, then press and release the 
P power button. Continue to hold down the ) paper 
button until the P power light flashes.

4. A test page prints the printer’s ROM version number and a 
nozzle check pattern.

❏ If the check page prints, the problem probably lies in 
your software settings, interface cable, or computer, or 
your software may not be installed correctly.

❏ If the check page doesn’t print, you may have a problem 
with your printer.

Try the suggestions in “Problems and Solutions” in the 
User’s Guide.

5. Turn off the printer, connect the interface cable, and turn 
on your printer and computer.

Replacing an Ink Cartridge

When the red H ink light flashes, an ink cartridge is low on 
ink. 

When the red H ink light stays on, you need to replace a 
cartridge.

You can open the printer cover to check the ink light 
indicating a cartridge that is low on ink or needs to be 
replaced. 

When a cartridge is more than six months old, you may need 
to replace it if printouts don’t look their best. If the quality 
doesn’t improve after cleaning and aligning the print head, 
you can replace the cartridge even if the red H ink light is off.

Lights Explanation

Green P power 
light flashes

The printer is receiving a print job, printing, replacing 
an ink cartridge, charging ink, or cleaning the print 
head.

Red H ink light 
flashes

An ink cartridge is low on ink. Make sure you have a 
replacement cartridge.

Red H ink light 
on

An ink cartridge is out of ink, not installed, not 
installed correctly, or is not compatible with the 
printer. Follow the steps on page 5 to install or 
reinstall the cartridge correctly.

The Photo Black or Matte Black cartridges were 
swapped during printing. Replace the original 
cartridge type in use before the error occurred.

Red ) paper 
light on

Your paper ran out, multiple sheets fed, or the 
wrong size sheet fed.
Sheet Feeder: If paper is out, load more paper and 
press the ) paper button. If multiple sheets or the 
wrong size sheet fed, press the ) paper button to 
eject the paper, then turn your printer off and then 
on. For loading instructions, see page 7.
Single Sheet Guide: See page 9 for instructions on 
loading single sheets of special papers. 
Roll Paper: See page 10 for instructions on loading 
or reloading roll paper.
Front Path: See page 11 for instructions on loading 
or reloading thick media.

Red ) paper 
light flashes

Jammed paper is blocking print head movement, or 
you’re trying to print on paper loaded into a path 
different than the path specified in the printer driver.
If you suspect a paper jam, turn off the printer and 
pull out the jammed paper. Open the cover and 
remove any jammed or torn paper. Then do one of 
the following:
Sheet Feeder or Single Sheet Guide: Turn on the 
printer, reload paper, and press the ) paper 
button. 
Roll Paper: Cut off the printed portion, then remove 
the paper and reload it (see page 10).
Front Path: See page 11 for instructions on loading 
or reloading thick media.

If a print job was sent to one paper path, but media 
is loaded only for another paper path, load the paper 
in the correct path.

Green P power 
light is on

Red ) paper 
light flashes 
quickly

Red H ink light 
flashes quickly

Jammed paper or a foreign object is preventing the 
print head from returning to the home position, or 
paper is loaded in the sheet feeder and the front 
path door is open.
Turn off the printer, open the printer cover, and 
remove any jammed or torn paper, or foreign object. 
Close the front path door if it is open. Then turn the 
printer back on. If the error persists, contact your 
dealer or Epson

Green P power 
light flashes

Red ) paper 
light flashes

Red H ink light 
flashes

An unknown printer error has occurred.
Turn off the printer, wait a few seconds, and turn it 
on again. If the lights are still flashing, contact 
Epson.

Lights Explanation
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Caution: Don’t open Epson Status Monitor or respond to any ink 
messages when your printer is printing. This may cause your 
printer to pause and leave an uneven surface on your printout. If 
your ink is running low, wait until printing finishes before checking 
ink levels or attempting to replace a cartridge. If you must replace 
an ink cartridge in the middle of a print job, the quality of your 
printout may decline. For best results, check your ink levels and 
replace ink cartridges, if necessary, before printing.

Checking the Ink Supply

To check your ink supply, do one of the following:

❏ Windows: Double-click the  icon on the Windows 
taskbar.

❏ Mac OS X: Choose Applications > EPSON Printer Utility 
> SP R2400 > EPSON StatusMonitor.

You see a window like this:

Click a cartridge image to display information about the 
cartridge (Macintosh), or click Information (Windows).

Purchasing Ink Cartridges

Use these Epson ink cartridges within six months of installing 
them and before the expiration date on the package:

Caution: To ensure good results, use genuine Epson ink cartridges 
and do not refill them. Other products may cause damage to your 
printer not covered by Epson’s warranty.

You can purchase ink cartridges, paper, manuals, and 
accessories from the Epson Store at (800) 873-7766 or visit 
http://www.epsonstore.com (U.S. sales only). In Canada, 
please call (800) 463-7766 for dealer referral.

Ink Cartridge Precautions

WARNING: Keep ink cartridges out of the reach of children; don’t 
drink the ink.

If ink gets on your hands, wash them thoroughly with soap and 
water. If ink gets in your eyes, flush them thoroughly with water.

Caution: To avoid damaging the printer, never move the print head 
by hand.

You cannot print if an ink cartridge is empty. Leave the empty 
cartridge installed in the printer until you have obtained a 
replacement. Otherwise the ink remaining in the print head nozzles 
may dry out.

Removing and Installing Ink Cartridges

Be sure you have a new ink cartridge before you begin. Once 
you start replacing a cartridge, you must complete all the steps 
in one session.

You can replace a cartridge whether the red H ink light is off, 
flashing, or on.

1. Make sure the printer is turned on (the green P power light 
should be on, but not flashing). Then open the printer 
cover.

2. Press the H ink button. 

The print head moves and the green P power light flashes.

If a red ink light is flashing or on (indicating a low or empty 
cartridge), the cartridge(s) indicated beneath the light(s) 
needs to be replaced. 

3. Lift up the cartridge cover.

4. Press in the tab on the back of the cartridge, lift it out of the 
printer, and dispose of it carefully.

Ink cartridge Part number

Light Light Black T059920

Light Magenta T059620

Light Cyan T059520

Light Black T059720

Photo Black T059120

Matte Black T059820

Cyan T059220

Magenta T059320

Yellow T059420
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5. Shake the new cartridge four or five times before opening its 
package. (Don’t shake it after it’s unpacked.)

6. Remove the new cartridge from its package.

Caution: Don’t touch the green circuit board on the front of 
the cartridge; you may inhibit normal operation and printing. 

 

7. Slide the new cartridge into its slot. The side with the green 
circuit board goes in the front of the slot.

8. Press the cartridge down until it clicks into place.

9. If you need to replace any other ink cartridges, repeat steps 
4 through 8.

10. Close the cartridge cover, press it down on the top until it 
clicks, then close the printer cover.

11. Press the H ink button. The printer begins charging the ink 
delivery system.

The green P power light and red H ink lights flash and the 
printer makes noise. Charging takes about 90 seconds. 
When it’s finished, the green P power light stops flashing 
and stays on. The red H ink light and the light(s) above the 
cartridge(s) go out.

Caution: Never turn off the printer while the green P power light 
is flashing, unless the printer hasn’t moved or made noise for more 
than 5 minutes.

Loading Paper in the Sheet Feeder 

1. Open the paper support and pull up the support extensions. 

2. Push in the bottom of the output tray. The tray opens and 
moves up. 

3. Pull out the output tray extension.

4. Place your paper in the printer and slide it against the right 
side of the sheet feeder.

Check the following as you load paper:

❏ Always load the short edge first, even for printing 
landscape-oriented documents.

❏ Load the printable side face up. It’s usually whiter or 
brighter than the other side.

Output tray

Output tray 
extension
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❏ Load letterhead or preprinted paper into the printer top 
edge first.

❏ Don’t load paper above the arrow on the left edge guide.

5. Adjust the left edge guide to fit lightly against the paper. 

Note: The left edge guide moves out slightly, then moves back in as 
the paper feeds into the printer. Do not adjust the guide during this 
movement or during printing.

Loading Special Paper in the Sheet 
Feeder 

You can load these Epson ink jet papers in the sheet feeder as 
follows:

* These matte papers require the matte sheet support when 
loading multiple sheets 11 inches wide or wider; smaller paper 
can be loaded without it. See page 8.

If the special paper has a cut corner, load the paper so the cut 
corner is positioned as shown here. Check the paper package 
for additional handling instructions.

Note: Always keep unused paper in the original package and store it 
flat to prevent curling. 

Loading Multiple Sheets of Matte Paper

If you are loading multiple sheets of the following papers in 
sizes 11 inches wide or wider, attach the matte sheet support 
to the top of the sheet feeder to help separate the sheets of 
paper and prevent misfeeds: 

❏ Epson Enhanced Matte Paper

❏ Epson Matte Paper Heavyweight

❏ Epson Double-Sided Matte Paper

1. Open the paper support and pull up its extensions.

2. Place the hook on the back of the matte sheet support over 
the paper support extension, and hold the top extension 
with one hand while sliding the matte sheet support all the 
way down. 

Note: Remove the matte sheet support when you load other types of 
paper. 

Paper type Loading capacity

Epson Enhanced Matte Paper*
Epson Matte Paper Heavyweight*
Epson Double-Sided Matte Paper*
Epson Premium Glossy Photo Paper
Epson Premium Semigloss Photo Paper
Epson Premium Luster Photo Paper

20 sheets (10 sheets 
for A3 or Super B 
sizes)

Epson Photo Quality Ink Jet Paper 100 sheets (50 
sheets for A3 or 
Super B sizes)

Epson Premium Bright White Paper 80 sheets

Epson Photo Quality Self Adhesive Sheets 1 sheet at a time

Cut corner

Matte sheet 
support
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Loading Special Paper in the Single 
Sheet Guide

Load these types of paper in the single sheet guide: 

❏ Epson Watercolor Paper - Radiant White

❏ Epson Velvet Fine Art Paper

❏ Epson UltraSmooth Fine Art Paper

❏ PremierArt Matte Scrapbook Photo Paper for Epson

1. Remove the roll paper holder, if it’s installed (see page 10); 
and close the paper support and its extensions.

2. Slide the roll paper edge guide all the way to the right. 

3. Line up the notches on the single sheet guide with the slots 
on the back of the printer and insert them as shown. Then 
insert the tabs on the top of the guide into the slot beneath 
the printer cover. 

4. Turn on the printer (the printer must be on to load paper in 
the single sheet guide correctly). 

5. Insert one sheet of paper against the right edge, then slide 
the left edge guide against the sheet. 

6. Guide the paper into the slot and feed it into the printer 
until the paper meets resistance. 

7. Maintain a constant pressure against the paper until the 
printer pulls it in slightly. Let go of the paper to allow the 
printer to adjust the paper position. 
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8. Open the printer cover and look down into the printer to 
make sure the paper is straight; if not, press the z roll 
paper button for 3 seconds to back the paper out. Press the 
) paper button to clear the paper out error, then load the 
paper again. 

9. Before printing, select Manual - Roll as the Source setting 
(Windows) or Manual - Roll as the Paper Source setting 
(Macintosh) in your printer software.

Loading Roll Paper 

You can load 4-inch, 8.3-inch, or 13-inch wide roll paper for 
printing multiple photos or panoramics, with or without 
borders.

Tip: It’s a good idea to check your ink levels before loading and 
printing on roll paper. (See page 6.) If you need to replace a 
cartridge with roll paper loaded, you should remove the paper or 
marks may appear in your printout.

1. Turn on the printer and remove any paper loaded in the 
sheet feeder at the top of the printer.

2. Close the paper support at the top of the printer.

3. If the output tray and extension are open, push them in, but 
leave the flap at the end of the tray down.

4. Swing out the roll paper guides until they are straight. 

5. Place the roll paper on the holders as shown, then remove 
the tape and protective paper from the end of the roll. 

6. Make sure the end of the paper is cut straight across, with 
90° corners. If the end is cut diagonally, you may have 
problems feeding the paper.

7. If the paper curls at the end, roll it backwards between a 
folded sheet of paper to uncurl it. 

Avoid touching the printable surface of the roll paper.

If crooked, reload
paper

90°
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8. Insert the left roll paper holder (marked with an orange 
triangle) into the far left slot (also marked with an orange 
triangle). Then insert the other holder into the 
corresponding slot on the right.

9. Load the paper part of the way into the roll paper feeder 
(under the white rollers), then slide the right roll paper edge 
guide to fit lightly against the paper.

Caution: Don’t load roll paper into the sheet feeder or the slot 
behind the paper support; make sure it is below the white 
rollers.

10. Push the paper into the feeder until the paper meets 
resistance. Maintain pressure on the paper until the printer 
feeds the paper automatically.

11. Open the printer cover and look down into the printer to 
make sure the paper is straight. 

If the paper is crooked, press the z roll paper button for 
three seconds to back the paper all the way out. 

Then turn the roll paper holder knobs to roll up the paper. 
Press the ) paper button to clear the paper out error. 
Repeat steps 8 through 10 to reload the paper.

Follow the instructions in your User’s Guide to print on roll 
paper.

Loading Thick Media in the Front Path

You can load media 1.3 mm thick into the front path, in sizes 
from 8 × 10 inches to A3+.

Note: Since the media feeds through the printer from the front to the 
rear, make sure there is enough space behind the printer for the 
media to move completely through the printer.

1. Turn on the printer and remove any paper loaded in the 
sheet feeder at the top of the printer.

2. Close the paper support at the top of the printer.

3. If the output tray and extension are open, push them in, but 
leave the flap at the end of the tray down.

4. Open the printer cover. Then open the front path door 
completely by pressing the front path door release area.

5. Close the printer cover.If crooked, press the 
z roll paper button for 
three seconds
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6. Insert the media two to three inches into the printer, and 
push the left edge guide against the media’s edge. Maintain 
slight pressure on the guide while inserting the media the 
rest of the way into the printer. Stop when the front edge of 
the media is aligned with the arrow on the right side.

7. Press the ) paper button. The media is fed into the printer 
automatically. When the P power light stops flashing, the 
printer is ready to print. (To remove the thick media 
without printing, press the ) paper button again.)

8. Before printing, select Manual - Front as the Source setting 
(Windows) or Manual - Front as the paper source setting 
within the Paper Size menu (Macintosh) in your printer 
software.

Note: If the printer fails to load the media and displays an error, 
remove the media and turn off the printer. Then turn the printer 
on again

Selecting the Media Type Setting

Select the correct Type or Media Type setting so your printer 
knows what kind of paper you’re using and adjusts the ink 
coverage accordingly.

Printing Borderless Cut Sheets

You can print your photos with no margins, extending the 
image all the way to the edges of the page. Although borderless 
printing is a bit slower, you get beautiful portraits and 
enlargements, without trimming, on these papers: 

❏ Epson Premium Glossy Photo Paper 

❏ Epson Matte Paper Heavyweight*

❏ Epson Enhanced Matte Paper*

❏ Epson Double-Sided Matte Paper *

❏ Epson Premium Luster Photo Paper

❏ Epson Premium Semigloss Photo Paper

❏ Epson Proofing Paper Commercial Semimatte

❏ Epson Watercolor Paper - Radiant White**

❏ Epson Velvet Fine Art Paper**

❏ Epson UltraSmooth Fine Art Paper**

❏ PremierArt Matte Scrapbook Photo Paper for Epson**

*If you are loading multiple sheets of matte paper that are 
larger than letter-size, use the matte sheet support. See page 8.

**These papers must be loaded in the single sheet guide. See 
page 9.

Caution: Don’t open Epson Status Monitor, pause printing, or 
respond to any ink messages when your printer is printing. This 
may cause your printer to pause and leave an uneven surface on 
your printout. If your ink is running low, wait until printing finishes 
before checking ink levels or attempting to replace a cartridge. If 
you must replace an ink cartridge in the middle of a print job, the 
quality of your printout may decline. For best results, check your ink 
levels and replace ink cartridges, if necessary, before printing large 
or high-resolution print jobs.

Paper or other media loaded Type or Media Type setting

Plain paper sheets
Epson Premium Bright White Paper

Plain Paper

Epson Photo Quality Ink Jet Paper
Epson Photo Quality Self Adhesive 
Sheets

Photo Quality Ink Jet Paper

Epson Enhanced Matte Paper Enhanced Matte Paper

Epson Matte Paper Heavyweight
PremierArt Matte Scrapbook Photo 
Paper for Epson

Matte Paper - Heavyweight

Epson Double-Sided Matte Paper Double-Sided Matte Paper

Epson Premium Glossy Photo Paper Premium Glossy Photo Paper

Epson Premium Luster Photo Paper Premium Luster Photo Paper

Epson Premium Semigloss Photo 
Paper 

Premium Semigloss Photo 
Paper

Epson Watercolor Paper - Radiant 
White

Watercolor Paper - Radiant 
White

Epson UltraSmooth Fine Art Paper Ultra Smooth Fine Art Paper

Epson Proofing Paper Commercial 
Semimatte

Proofing Paper Semimatte

Epson Velvet Fine Art Paper Velvet Fine Art Paper

Paper or other media loaded Type or Media Type setting
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Windows

1. Start your printing application and open your photo file.

2. Open the File menu and click Print, then click Properties 
or Preferences. 

3. Select Photo or Best Photo as the Quality Option.

4. Choose Sheet or Manual Roll as the Source setting.

5. Select the type of paper you loaded as the Type setting. 

6. Click the Borderless checkbox.

7. Select your paper size as the Size setting.

8. Select Portrait or Landscape as the orientation setting.

9. Click the Page Layout tab, then adjust the Expansion 
setting. Choose Min for the least amount of image 
expansion (with a chance that there may be small borders 
around the edges) or Max for the greatest amount of 
expansion (some of the image will be cut off around the 
edges, but it will extend to the edge of the paper). 

10. Click OK.

11. Click OK or Print.

Mac OS X

1. Start your printing application and open your photo file.

2. Click File > Page Setup.

3. Select Stylus Photo R2400 as the Format for setting.

4. Select the size of the paper you loaded with a Sheet Feeder 
- Borderless source as the Paper Size setting.

5. Select one of the portrait or landscape orientation icons as 
the Orientation setting.

6. Click OK.

7. Click File > Print.

8. For the Printer setting, select Stylus Photo R2400.

9. Select Print Settings from the pop-up menu.

10. Select the type of paper you loaded as the Media Type 
setting. 

Note: If you can’t choose your paper type, check your Page 
Setup settings to make sure you selected the correct paper size 
and source. 

11. Move the slider to the Quality setting. 

12. Choose Expansion from the pop-up menu, then adjust the 
Expansion setting. Choose Min for the least amount of 
image expansion (with a chance that there may be small 
borders around the edges) or Max for the greatest amount 
of expansion (some of the image will be cut off around the 
edges, but it will extend to the edge of the paper). 

13. Click Print.

Cleaning the Print Head

If your printouts are unexpectedly light, or dots or lines are 
missing, you may need to clean the print head. This unclogs 
the nozzles so they can deliver ink properly. Print head 
cleaning uses ink, so clean it only if quality declines. 

Caution: When you don’t turn on your printer for a long time, print 
quality can decline, so turn it on at least once a month to maintain 
good print quality.

Select Stylus 
Photo R2400 as 
the Format for 
setting

Select the size 
of the paper you 
loaded here
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This section explains how to clean the print head using the 
Auto Nozzle Check and Cleaning utility and the Head 
Cleaning utility. Use the Auto Nozzle Check and Cleaning 
utility first, to let the printer check and clean the nozzles. If 
you still notice problems with quality, you can manually clean 
the print head. 

Note: You can also clean the print head by holding down the H ink 
button on the printer for three seconds (when the red H ink light is 
off).

Automatically Checking and Cleaning the 
Print Head

The Auto Nozzle Check and Cleaning utility prints a nozzle 
check pattern that the printer then reads to see if you have any 
clogged nozzles. If cleaning is needed, the printer 
automatically cleans the print head.

1. Make sure the printer is turned on but not printing, and the 
red H ink light is off. (If the H ink light is flashing or on, you 
need to replace a cartridge; see page 5.)

2. Load several sheets of plain, letter-size (8.5 × 11 inches) 
paper in the printer’s sheet feeder.

Note: Sizes smaller than letter, including 8.5 × 10 inches, won’t 
work. 

3. Do one of the following:

Windows: Right-click the  icon on your taskbar (in the 
lower right corner of your screen). Select Auto Head 
Cleaning.

Mac OS X: Open the Applications folder and select 
EPSON Printer Utility. Select SP R2400, click OK, and 
select Auto Nozzle Check and Cleaning.

4. Follow the instructions on the screen. The printer prints 
and examines the nozzle check pattern shown below. If 
cleaning is necessary, it then cleans the print head and prints 
and checks another nozzle check pattern.

5. The utility prints and checks up to five times. If some print 
head nozzles are still clogged, it displays an on-screen 
message telling you to manually clean the print head. 
Follow the instructions in the next section to clean the print 
head, if necessary.

If you still have print quality problems, check the solutions in 
the User’s Guide. You can also turn the printer off and wait 
overnight—this allows any dried ink to soften—and then try 
cleaning the print head again.

Running the Head Cleaning Utility

1. Make sure the printer is turned on but not printing, and the 
red H ink light is off. (If the H ink light is flashing or on, you 
need to replace a cartridge; see page 5.)

2. Do one of the following:

Windows: Right-click the  icon on your taskbar (in the 
lower right corner of your screen). Select Head Cleaning.

Mac OS X: Open the Applications folder and select 
EPSON Printer Utility. Select SP R2400, click OK, and 
select Head Cleaning.

3. Follow the instructions on the screen to clean the print 
head. 

Cleaning takes about two minutes, during which the printer 
makes noise and the green P power light flashes.

Caution: Never turn off the printer while the green P power 
light is flashing, unless the printer hasn’t moved or made 
noise for more than 5 minutes.

4. When the green P power light stops flashing, make sure 
paper is loaded in the printer. Click Print nozzle check 
pattern, then click Print (Windows) or click 
Confirmation, then click Next (Macintosh). The nozzle 
check pattern prints.

5. If the nozzle check pattern has no gaps or lines (as shown 
below), click Finish.
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If the pattern has white lines or gaps (as shown below), click 
Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head 
three or four times, check the solutions in the User’s Guide. 
You can also turn the printer off and wait overnight—this 
allows any dried ink to soften—and then clean the print head 
again. 

Aligning the Print Head

If your printouts contain misaligned vertical lines, or you see 
light or dark horizontal banding, you may need to align the 
print head. You can have the printer automatically check and 
align the print head or you can check and adjust the alignment 
yourself.

Automatically Aligning the Print Head

1. Turn on the printer.

2. Load plain, letter-size paper.

3. Do one of the following:

Windows: Right-click the  icon on your taskbar (in the 
lower right corner of your screen). Select Print Head 
Alignment.

Mac OS X: Open the Applications folder and select 
EPSON Printer Utility. Select SP R2400, click OK, and 
select Print Head Alignment.

You see a screen like this:

4. Click the Automatic button, if necessary, then click OK.

5. On the next screen, click Start. The printer then prints and 
checks an alignment pattern. It then prints and checks two 
more patterns.

6. When alignment is finished, click Finish on the last screen. 

Manually Aligning the Print Head

1. Turn on the printer.

2. Load plain, letter-size paper.

3. Do one of the following:

Windows: Right-click the  icon on your taskbar (in the 
lower right corner of your screen). Select Print Head 
Alignment.

Mac OS X: Open the Applications folder and select 
EPSON Printer Utility. Select SP R2400, click OK, and 
select Print Head Alignment.

4. Click the Manual button, then click OK.

You see a screen like this as the printer prints an alignment 
check pattern:

5. On the check page, select the box in each pattern that has 
the least noticeable lines in it. You may need to use a 
magnifying glass or loupe.

Select one box for each pattern numbered 1 through 3. 
Then enter the box number for each pattern in the boxes on 
the screen. 

If box #5 is not the best-aligned box in each pattern, click 
Realignment to print another test page and repeat this 
step.

6. When box #5 is the best-aligned in all the patterns, click 
Finish.

Cleaning the Printer

To keep your printer working at its best, you should clean it 
several times a year.

1. Turn off the printer, unplug the power cord, and 
disconnect the interface cable.

2. Remove all the paper, then use a soft brush to clean the 
paper feeders.
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3. Clean the exterior of the printer with a soft, damp cloth. 
Keep the paper support and printer cover closed as you 
clean the printer.

4. If you need to clean ink out of the inside of the printer, use 
a soft cloth to clean only the black plastic area shown below:

WARNING: Don’t touch the gears or rollers inside the printer.

Caution: Never use a hard or abrasive brush, or benzine, alcohol, or 
thinner for cleaning; they can damage the printer components and 
case. 

Don’t get water on the printer components and don’t spray or apply 
lubricants or oils inside the printer.

Don’t use any cleaning sheets included with special paper; they 
may jam inside the printer. 

Transporting the Printer 

If you move your printer some distance, you need to prepare it 
for transportation in its original box or a similar one. Follow 
these steps:

1. Turn on the printer.

2. Turn off the printer and unplug the power cord from the 
electrical outlet. Then disconnect the printer cable from the 
printer.

3. Open the printer cover and tape the ink cartridge holder to 
the printer case using tape. Then close the printer cover.

Caution: Be sure to remove the tape after installing the printer in 
its new location.

4. Remove any paper from the printer, then remove the roll 
paper holder, if it is installed.

5. Close the output tray and the paper support.

6. Repack the printer and its attachments in the original box 
using the protective materials that came with them.

7. Keep the printer level as you transport it. 

8. After transporting the printer, remove all the tape. 

9. Test your printer. If you notice a decline in print quality, 
clean the print head (see page 13); if output is misaligned, 
align the print head (see page 15). 

Related Documentation

Epson Stylus Photo R2400 Start Here sheet CPD-19427

Epson Stylus Photo R2400 User’s Guide CPD-19428

Epson Stylus Photo R2400 CD-ROM CPD-19426

Epson Stylus Photo R2400 Reference Guide 
(on CD-ROM)

Clean here 
only

Tape the ink 
cartridge 
holder to the 
printer case
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